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Device List

Item

Quantity

Unit

Scan head

1

set

Adapter

1

pc

Power line

1

pc

Aviation plug

1

pc

Calibration board

1

pc

Mark points

1

set

Installation Guide

1

pc

Turntable

1

pc

Tripod

1

pc

Industrial Pack

Scan head tray

1

pc

（add-on module）

USB line

1

pc

Power adapter

1

set

Power line

1

pc

Texture camera

1

pc

Prime camera

1

pc

Basic
Version

Color pack
（add-on module）
Prime pack
（add-on module）
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Specification Parameter

Model

EinScan-Pro+

Scan Mode

Handheld HD
Scan

Handheld Rapid Scan

Accuracy

0.1mm

0.3mm

Scan speed

0.55 mil points
/sec

0.45 mil points /sec

Point distance

0.2mm~3.0mm

0.7mm~3.0mm

Fixed Scan( with
turntable )
Single Scan
Accuracy: 0.05mm

Fixed scan ( without
turntable )
Single Scan
Accuracy: 0.05mm

Single Scan: <2sec

Single Scan: <2sec

0.24mm

Single Scan
Range

300*170mm

Light source

White light LED

Part Size Range
(Recommend)

0.03m~4m

0.15m~4m

0.03m~0.15m

0.03m~4m

Align Mode

Mark Point Align
Global Mark Point
Align

Markers/Feature
Align
Mixed Align
Global Mark Point
Align

Turntable Align
Mark Point Align
Feature Align

Compatible:
Mark Point Align
Feature Align

Texture Scan

No

Outdoor
Operation

Yes (texture scan camera and software module shall be bought)
No (affected by strong light)
Feature Align： need

Special Scan
Object

--

--

Rich Surface
Feature needed

--

For transparent, reflective and dark object, please spray powder first before scanning
Printable Data
Output
Data Format
Scan Head
Weight
System Support
Computer
Requirements

Yes
OBJ, STL, ASC,PLY,3MF
0.8KG
Win7/Win8/Win10
64bit
CPU: I5 or Higher; Display card：NVIDIA GTX660 or higher; Display memory：>2G; Memory
Storage：8G or more
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Hardware Installation

Basic Module
Connect one end of the line to the scanner, the other end to power line and USB on the
computer as shown in the picture. Connect to USB2.0 or USB3.0. (This installation mode is
suitable for Handheld Scan.)

Industrial module installation
Put the basic module on the tripod when the installation finishes. Connect the long-opening
end of USB line to the computer, the square-opening end to the turntable. Then connect the
power adapter to the turntable and adjust the position of scan head and turntable. (This
installation mode is suitable for Fixed Scan.)
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Software Installation

Software download
Firstly, enter the Support page: http://www.einscan.com/support. Click “Software download”, as
shown below:

Secondly, please complete the registration, if registered, click log in.

After take the survey, it will enter the page http://www.einscan.com/software-download

Finally, click the icon to jump to the page of any file to download the software.
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Software Installation

Double click installation package, Follow the instructions as the window pops up. Users can
either choose the default installation path or click the Browse button to select the installation
path. Default installation is suggested.

When installation is finished, there will be a shortcut of the software
desktop.
The shortcut in the Start Menu is shown as below:

and

on the

The shortcuts are:
Software
File Preview Tool
Teamviewer
Uninstall

In the next step, connect the device and check
whether the camera driver installation is successful, right
click
“Computer”,
choose
“Computer
Management”-“Device Management”-“Imaging devices”
to check if the two cameras display normally (two cameras
will be found when there is no color module).
When there is color module, check if there are three
cameras, as shown below.
When there is prime module, check if there are four
cameras.

Software Uninstall
Open the start menu, choose Shining3d_EinSca-Pro----Click “Uninstall” or go the Control
Menu to uninstall.
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The software provides Fixed Scan, Handheld HD Scan and
Handheld Rapid Scan, and taking into account the portability
and high-precision.
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Scan Preparation

Mode selection
 Fixed Mode
(1) Fixed Scan( With Turntable ): This mode is recommended for objects within the size of
200*200*200mm. For example, small workpieces.
(2) Fixed Scan( Without Turntable ): This mode is recommended for objects over the size of
200*200*200mm, while high details and resolution, as well as a comparative stable environment
(without obvious vibration) are required. For example, industrial parts which require high details
and resolution.

 Handheld Mode
(1) Handheld HD Mode：When the size of the object is over 30*30*30mm, environment is not
stable or with vibration, sticking mark points on the object is allowed, high resolution and details
are required, this mode is recommended. For example: Industrial part, sculpture, or art works
with rich details.
(2) Handheld Rapid Scan：When the size of the object is over 150*150*150mm, environment is
not stable or with vibration, surface is not with much detail pattern, this mode is recommended.
For example: Human body (the whole body, face, chest, hand, foot and other parts), sculpture
that doesn’t require high detail.

Mark points stick
Stick mark points on the object in random, avoiding sticking in one line. The single scan
range is 300mm X 170mm, public areas alignment require at least four mark points. While placing
the points, uniformly stick the mark points on the object, and make sure that in each single scan
area has at least 4 points.

Special objects
Before scan objects in transparent, semi-transparent or black shall spray on the surface.
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First Scan

If add the prime module, before use it, you need to upgrade, or the HD prime module won’t be
used. Open the software and it will detect the current firmware whether is need upgrade. If the
firmware upgrade, it will pop-up the dialog below, click Yes to start upgrading.

Note: During upgrade process, it is necessary to ensure that the scanner will not be cut off.
After the upgrade is completed, the scanner needs to be cut off.

Choose the device “EinScan-Pro+”, as shown below.

3.3.1. Help Mode for Beginners
Close Help Mode for Beginner by clicking the top right corner

. To open Help

Mode for Beginner, go to Menu -> User Setting ->Help Mode for Beginner

3.3.2. Obtain License File
When a warning of license file doesn’t match the scanner pops up when entering scanning mode,
the license file can be acquired by clicking “ Activate”
12

First Scan

3.3.3. Operation Procedure
Operation Procedure
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First Scan
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Drop down Menu

Click

from the upper right to open drop down menu.

3.4.1. Language
This software version is including Simplified Chinese, Chinese, English, German, Japanese,
Spanish, French, Korean, Russian and Turkish. Language can be switched in the choose device
type and choose scan mode interface.

3.4.2. TeamViewer
By clicking TeamViewer, you can go to the TeamViewer interface directly without installation.
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Drop down Menu
3.4.3. Feedback
If you have any questions, or suggestions, please share with us by clicking “Feedback”. Leave
your email in “ My E-mail”

3.4.4. User Setting

3.4.4.1.

Debug window

Tick the checkbox to open debug window; if you want to close it, unselect it.

3.4.4.2.

Help Mode for Beginners

Help Mode for Beginner is the default selection, which is to guide the new users make a scan
completely step by step. Close Help Mode for Beginner by clicking the top right corner
. To open Help Mode for Beginner, go to Menu -> User Setting
->Help Mode for Beginner
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Drop down Menu
3.4.4.3.

Handheld mode saved project automatically

Tick the checkbox of “Project will be saved automatically when the scanning is paused
under handheld mode”, when pause scan, project will be saved automatically under
handheld HD mode and handheld rapid mode .

3.4.4.4.

User Experience Program

To help us improve the quality and user experience of Einscan, we hope to be allowed to
collect usage information to Einscan Team. This information will not identify you and does not
include your project data. By default, this checkbox is selected, and we strongly recommend you
to select it.

3.4.5. Factory Default
System setting (brightness, turntable steps), calibration data will restore to the factory
default settings. Language will be changed into English as default. Factory Default will require
software restart.

3.4.6. Einscan Community

Official Website ( http://www.einscan.com/ ) refers to SHINING3D official website for product
and information.
Community ( http://www.einscan.com/einscan-experts-forum ) refers to SHINING3D forum for all
EinScan users to discuss and share the experience.
Facebook (https://www.facebook.com/groups/einscan ) refer to facebook for Einscan users to
discuss and share the experience.

3.4.7. About
Software version information, and technical support mail can be found here.
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Drop down Menu

You can open file preview tool

through a desktop shortcut or from the start menu. Start

previewing by dragging the file into the window. Supporting formats include asc., stl., ply., obj.,
and 3mf. As the picture shows below, file path shows in the title bar.
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Scanning cannot be entered if calibration is not done after
installing the software. There is a WARNING: No calibration
data, please calibrate first.
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Calibration
After software installed, in the choose device type interface choose “Pro+”, click “Next”, the
software will enter the calibration mode.
It will show the below picture if the device only has two cameras. (Texture camera is not
attached). The left side guide bar include camera calibration.

It will show the below picture if the device has three cameras. (With texture camera). The left
side guide bar include camera calibration and white balance calibration.

There are two calibration steps if the device without texture camera:
①camera calibration ;
There are two calibration steps if the device with texture camera:
①camera calibration White balance calibration.
Note:
Calibration board SN is under the camera viewport, you should choose the
corresponding calibration board.

Take the scanner with texture camera as an example (without texture camera, it only takes the
first steps).
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Camera Calibration

The left side of camera calibration interface is guide bar, right side is calibration video.
Calibration board need to be placed in five positions during calibration, each captures five
pictures. Place the board according to software guide.
First, adjust the distance between projector and calibration board (450mm-550mm) according to
software guide. Step 1, place the calibration board flatly in accordance with the direction in the
picture, keep the cross pattern projected by the scanner in the white frame on the calibration
board.
Note: During calibration, keep the scanner perpendicular to the plane which places the
calibration board, as shown below.

Click

in the software or

on the scanner to capture snaps automatically. During

capture process, software picture shows the scanner projecting light. Move the scanner from top
to bottom or from bottom to top, until the rangefinder is filled in green, which means Step 1
capture is finished, with software giving a beep sign. During capture, lift the scanner up when
software shows “too close”; move the scanner down when software shows “too far”.

Note:
1. When the distance bar is ticked, it means pictures of this position are collected. Blue
means the current position.
2. Keep the cross in the white square area when moving the calibration.
3. During calibration, keep the scanner perpendicular to the plane which places the
calibration board.
21

Camera Calibration
When pictures of one position are well collected, the software will turn to the next position with
buzzer as below:

Put the calibration board on the support according to the instruction. The collection is same
as above. When all five positions photos are captured, the software will calibrate the camera
automatically. You will see the progress bar as below.

The camera calibration may keep for a long time in 52%, please be patient. When IT is finished,
you’ll see “Camera calibration success”. The software will enter Color camera white balance
mode automatically.
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White balance calibration

During the texture calibration, just place texture camera towards white area of the reverse
side of calibration board, click

or

on the hardware, and move the scanner up and

down, until one box is ticked, and the white balance test is completed. The picture below will
show up when the calibration is successful.
When calibration is finished, the software will close the calibration window automatically
and enter the scan mode selection page.
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Calibration Precautions

You must finish all the calibration steps according to the instruction when you calibrate at
the first time. If resolution is lost under HD Mode, or environment light changes and influences
the scanning, you can do line calibration or white balance calibration solely.
Situations as below need do calibration again:

① When the scanner is used for the first time or after long time without using.
② When there is strong vibration during the transportation.
③ When alignment mistake or failure frequent appear during the scanning.
④ When environment light changes under Color Scan, white balance calibration is
needed.
⑤ When scanning data is incomplete and quality is much worse during the
scanning.
Note: Make sure to keep the calibration board still and then click “Snap” to collect
during calibration.
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Accuracy Diagnostic

If markers can’t be recognized, tracking lost or misalignment happens often, you can do
Accuracy Diagnostic. If the result of the tolerance is big, please recalibrate.
Choose Accuracy Diagnostic from the calibration tool bar in the right, the way is same as
camera calibration. Place the calibration board flatly, point the scanner cross on the middle white
frame up and down slowly till all boxes getting green ticks.

The result of the accuracy tolerance will be shown

. Go back to

scan mode selection page by clicking “quit” at the left bottom.
Note: Recalibration is recommended when result is above 0.1mm.
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Help Mode for Beginner

Choose Fixed Scan, click ‘Next’ to enter the interface.

Help Mode for Beginner is the default selection, which is to guide the new users make a scan
completely step by step. Close Help Mode for Beginner by clicking the top right corner
. To open Help Mode for Beginner, go to Menu -> User Setting
->Help Mode for Beginner
Under the Help Mode for Beginner, following the guidance step by step, you will finish a scan
following: New Project -> Texture/Non-texture ->adjust brightness -> start scanning -> Edit ->
->Continue Scan/Mesh -> Mesh type: Watertight/ Un-watertight -> Post Processing -> Save data
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Fixed Scan

Enter the interface of New Project and Open Project, the default project save location is the
desktop, then it will remember where the user last created a new project. Click “New Project”,
enter the project name, then click ‘Save’ to enter the interface of Non-texture Scan and Texture
Scan selection. Texture scan is only active when the scanner is with texture camera.

In the new project interface, select

, can import three

formats as asc, txt and p3. Note：the use of global markers file, the only point in the framework
can scan. Global markers point can be deleted.
Enter the interface of fixed scan, check “With Turntable”.

5.2.1. Before Scanning
5.2.1.1.

Tick

Camera viewport

to display the right camera viewport and texture
28

Fixed Scan
camera viewport. The left camera viewport always display.
Click

5.2.1.2.

in the lower right corner of the camera viewport to zoom the camera viewport

Work distance

Adjust the distance between the object and device (suitable working distance is 450 ~ 550mm),
until the cross is clearly to be seen on the object.

5.2.1.3.

Adjust Brightness

Drag the button to adjust the brightness. The
brightness is appropriate at the right scan distance:
equipment against objects, the cross is clearly in the brightness viewing window.

5.2.1.4.

With Turntable

If you don’t choose “With Turntable” option, you will get single piece of
data; if choose this option, the scanner will use turntable to scan and choose turntable steps as
well as align mode.

5.2.1.5.

Turntable Steps
Before scanning, you can set the scan times per round
under turntable scan. The default setting is 8 times.

5.2.1.6.

Align Mode
The default is turntable coded targets align mode，you can also choose
markers or feature align mode. Align mode can be re-selected after the
turntable has rotated one circle.

If you import global markers point file when creating a new project, the align mode is global
mark point, and the project cannot change to other align mode. In the new project interface,
select

, can import three formats as asc, txt and p3.
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Fixed Scan
Import global mark point. Note：The use of global markers point, the only point in the framework
can scan.

Note：

1. Choose turntable coded targets align mode, Please make sure that the
object won’t block the coded targets on the turntable. Or, there will be no
fringe pattern, while turntable will be still rotating. If the scanned object is
too high and will block the coded target on turntable, you can stick mark
points on it (if allowed) to continue auto scan. At this time, please make
sure that the coded target on the turntable are covered, so as not to affect
the scanning. Make sure that in each single scan area has at least 4 points.
Refer to Scan Preparation.
2. Feature align, when scan it will verifying and scan 3 piece of data.

5.2.1.7.

HDR
Enable HDR brightness can scan bright and dark objects.

5.2.2. Scanning
5.2.2.1.

Start Scan

Click the button or press space button to start scanning. After the turntable has rotated
one circle，you can change you can change with turntable or not, turntable steps and align
mode.

5.2.2.2.

Edit Tool

Edit buttons: ①Deselect ②Revert ③Delete ④Undo
⑤Show/Hide Stripe ⑥Shift + Left mouse: choose data ⑦Ctrl +
Left mouse: deselect selected data
You can edit the current part data after each scan. You can do the below edition if the data has
excess parts, both data and mark points can be edited.
SHIFT+Left mouse：Select excess parts, the selected section is displayed in red, as shown below.
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Fixed Scan

Ctrl + Left mouse: deselect selected data
Delete selected data
Click the button or “DELETE” in the keyboard to delete
selected data.
Undo
You can only undo the last deleted data.

Show/Hide Stripes
Click the button to switch the texture display and hide. Non-texture scan, there is no
such button.

5.2.2.3.

End single-piece edit

Click

or press space button to save data and exit the single-piece edition; Click

,

delete the current scan dat.
After end the single-piece edit, the right toolbar will display, and now can edit the whole scan
data. The specific operation is the same as the single-piece edit.

5.2.2.4.

Manual Align

If automatic alignment failed during scanning, you can use manual align. Click the button
to open Manual Align view port on the left side of the software. Keep SHIFT down, and
click left mouse button to select at least 3 non-collinear corresponding points in the 3D preview
31

Fixed Scan
windows for Manual align, as shown on the right.

5.2.2.5.

Delete Current Data

If you are not satisfied with current scanning data, or
there is not enough overlapping region for registration,
click the button to delete current data and then change the
position of the scanner or the object to scan again.
When auto scan mode is scanning, you can click the
button to stop the current scan. The current data will be
deleted directly.
When import project, click the button and it will remove the
single data.
Note: If you choose wrong points under manual alignment, you
may press Esc button to cancel the points one by one in order,
until you exit manual alignment.

5.2.2.6.

Pause

Click the button, scanning will pause; Click again to resume scanning.

5.2.3. After Scanning
5.2.3.1.

Mesh

When the scan is completed, click the botton, proceed to post-processing. You will see
two modes after clicking the button: Watertight and Unwatertight. Watertight usually
slower than unwatertigt. Texture scan mode will take more time compared to Non-Texture scan
mode.
Watertight
Closed model can be printed directly. After choose this mode, you should select
the object details.
Select High for objects with fine texture, select Med or Low for objects in smooth
surface or with less detail. The time for data processing is in relation to the detail
setting. The higher the level of details is, the longer time the processing takes. It may keep for a
long time in 95%, please be patient.
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Fixed Scan

Select the object details：

Unwatertight
Unclosed model. The following picture is the watertight and unwatertight model.

Watertight

Unwatertight

Texture watertight results:
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Fixed Scan

5.2.3.2.

Data Post Processing

After meshing, the following dialogue box of data post processing will appear. You can simplify
the data per your request, do fill holes, sharpening or smoothing operations. Unwatertight and
watertight, the post processing of the interface as shown below.

Data simplification
After simplification, the polygon numbers, size and surface detail of data will be reduced
accordingly. Check the simplify check box and set the ratio, the default is 100%.
The comparison of detail between before simplification and after simplification (at 30% simplify
proportion).
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Fixed Scan

Before simplification

After simplification

Fill holes
The default does not check the mark point and fill hole, check the fill hole you need set
perimeter, choose 10-100mm perimeter to fill the hole, less than the perimeter of the hole will
be filled. Mark point fill hole as an example.

Before

After

Note：
1. If the edge of the hole is not smooth may cause the effect is not good, not
recommended to fill hole.
2. Hole-filling: choose 10-100mm perimeter to fill the hole;

Smooth
The data to denoise processing, improve data quality, the figure before and after smoothing:
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Fixed Scan

Before smooth

After smooth

Sharpen
Improve the overall clarity of the data, the figure below before and after sharpening:

Before sharpen

After sharpen

Optimize the texture
This option is only available when the scan data is with texture. Click this function to optimize
color texture of the model, which can make the color closer to the model but take more time for
processing.

Not optimize

Optimize texture
36

Fixed Scan
Texture layout optimization
If you need to edit the texture later, you can select this function, but this is time-consuming.

No optimization

5.2.3.3.

Texture layout optimization

Brightness/Contrast

After meshing project with texture, you may adjust brightness/contrast under the camera
viewport.
Brightness (-100—100): shows the brightness of the picture. The higher the value is, the brighter.
Contrast (-100—100): shows the contrast of the colors. The higher the value is, the more color
gradient layers.

5.2.3.4.

Save Your Data

Before merging can save data as asc single. After merging, it can be saved as asc, stl,
ply,3mf and obj.

5.2.3.5.

Scale

Scaling the volume of scanning data, while the quantity of triangular facets and size of data
will not be changed.
37

Fixed Scan
Scaling result as reference: From left to right shows double size, original size and half size
respectively.

Scale window

5.2.3.6.

Scale result

Share Your Data

Click the button after merging to share data, it will show the dialog as below.
You can share your model to Sketchfab, while model title, username and user password
are required. Register an account and look at the shared model at http://sketchfab.com.

Note：
Sketchfab Normal account can only upload data maximum 50M, while Professional
account can share maximum 200M, and set model as private.
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Fixed Scan

5.2.3.7.

Solid Edge

If Solid Edge software is already installed, click the button
meshed STL data will also be exported to Solid Edge.

5.2.3.8.

to open the software. The

Project

You can new or open projects. The default project location is the desktop, then it will
remember where the user last created a new project.
Note：
1. The scanning projects created by different scan modes (Industry fixed scan,
handheld HD scan and handheld rapid scan) cannot be reciprocally imported. The
projects created by auto scan and fixed scan ( without turntable ) can be
reciprocally imported.
2. After importing the project, direct access to scan, choose the scan mode based on
whether the imported project is texture. The texture project cannot be continued
to scan if the scanner is without color texture camera.

5.2.3.9.

Back to Home

If you want to change the scan modes, click the button to go back to the homepage to
39

Fixed Scan
select the scan mode.

5.2.4. Others
5.2.4.1.

Mouse Operation Prompts

Lower left corner of the interface is the mouse operation prompts:


Hold down the left mouse button: Rotate the object;



Hold down the middle mouse button: pan the object;



Hold down the mouse wheel: Scroll up and down to the object; scroll down to enlarge
the object;



Hold down the Shift + left mouse button: select the area on the object;



Hold down the Ctrl + left mouse button: deselect selected data;



Delete: Delete the selected area.



Press and hold shift + left mouse click: Select point to start manual align

5.2.4.2.

Hot Key

Space button: To start scan or during single-piece edit to save data and exit the single-piece
edition.
ESC button: To close the pop-up windows, such as new project, select texture, choose mesh type
and so on.

5.2.4.3.

Points and Triangle

When scanning it will show the current points and
current triangles in the lower right corner. When
you edit the scan data, the current points and the current triangles change in real time.

5.2.4.4.

Help
Click this button to get the operation manual and notes in more detail under the
current step.
The following picture shows the help information of new project.
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Fixed Scan

5.2.4.5.

Model Viewer

Einscan software can be a 3d viewer for ASC, OBJ, STL format file. Drag the 3d model to
Einscan software under scanning mode interface.
Click
on the 3d viewer window will close the model view. The scanning window will
be not affected.
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Fixed Scan

You can use software without scanner connection. You can do edition, manual align, delete, mesh,
save data, share data and so on.

42
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Scan head key function

Scanning distance indicator:
Green for best distance;
blue for too far, red for too
close. The color is same as
the
distance
bar
in
operation interface.

“ - ”“ + ”： During the
scanning, zoom in and
out in view of data
under exposure window ，
“-”
“+”can adjust the
brightness .
Scan/pause button: click the
button to pause or start
scanning.
Double click to activate
exposure
adjustment
window.
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Help Mode for Beginner

Choose Handheld Rapid Scan, click “Next”, as shown below:

Help Mode for Beginner is the default selection, which is to guide the new users make a scan
completely step by step. Close Help Mode for Beginner by clicking the top right corner
. To open Help Mode for Beginner, go to Menu -> User Setting ->Help
Mode for Beginner
Under the Help Mode for Beginner, following the guidance step by step, you will finish a scan
following: New Project -> Texture/Non-texture, Resolution -> Preview-> Adjust
brightness->start scanning ->Pause scanning -> End Edit -> Generate point cloud -> Continue
scan/Mesh -> Mesh type: Watertight/ Un-watertight -> Post Processing -> Save data
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6.3.1. Before Scanning
Enter the interface of new project, as shown below, click “New Project”, type the project
name, then will pop-up the interface of texture scan and resolution selection. Texture scan is only
active when the scanner is with texture camera. The process of Non-texture Scan and Texture
Scan are same.

Select Resolution
The higher the resolution, the better the details. If select the “More setting of Resolution”,
you can drag the sliding block to other locations, flexible choice of point distance.
Handheld Rapid Scan point distance range: 0.7mm—3.0mm, high 0.7mm, medium 1.0mm,
low 1.5mm.

Note：
1.Higher resolution takes more time to scan and consumes more memory of
graphic card，and size of the object to be scanned will be limited. Theoretically, the
maximum size of scan = point distance*8192/mm. In actual process, the size of the
object can be scanned depending on computer graphic card.
2. Choose high resolution, the data output is slow, please be patient.
3. When import project, and continue the scan, the scanning will be in accordance
with the imported project resolution and align mode.

Select Texture
If texture camera is not attached, when you select texture,it will pop-up a dialog as shown below:
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, can import three formats as asc, txt
and p3.
Note：The use of global markers file, the only point in the framework can scan.
Select Align Mode
Markers/Feature: f the surface of the object has mark points, the software will recognize the
mark points and scan. If there are no mark points，it will use feature alignment.
If you choose mixed alignment, the software can switch between feature and marker
alignment automatically during scanning according to the surface of the scanned object (with
markers or not). For some parts which are difficult for feature alignment, you may stick markers
(≥4 markers) to help with alignment.
The interface of Handheld Rapid Scan:

6.3.2. Preview
6.3.2.1.

Tick

Camera viewport

to display the right camera viewport and texture

camera viewport. The left camera viewport always display.
Click

in the lower right corner of the camera viewport to zoom the camera viewport
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6.3.2.2.

Preview

Point the scanner to the object, then click
on software or press
on scanner
to run into PREVIEW mode. In this mode, it will start to capture data, but not recorded. In this
mode, you can:
1. Check working distance, and field of view for scanning;
2. Adjust a proper brightness before scanning.

6.3.2.3.

Adjust Brightness

1. When scanning distance is adjusted properly, double click
pressing “+, -“ button on the scanner. Double click

, and adjust the brightness by

to exit the brightness adjustment.

2. Brightness can be also adjusted via the brightness slider under the camera window
on the left side.
3. Brightness can be adjusted during scanning.
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To bright(X)

6.3.2.4.

Good(√)

To dark(X)

Rangefinder

Rangefinder is on the left side. It reveals different colors based on the distance between the
scanner and the object. At the correct distance, it will show green. If it is too close it will show
red and if it is too far it will show blue. Please adjust the scanner position until the rangefinder
color turns green.

Too Close
When brightness adjustment is over, click
start scan recording.

Good

Too Far
on the scanner or

in the software to
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Note:
1. Preview mode is needed every time for brightness adjustment when a new
project is built or an existing project is imported for continues scanning.
2. When open project, if click

, preview mode is no longer available.

6.3.3. Scanning
6.3.3.1.

Start scan

Click the button or the button

on the hardware to start scanning.

When start scanning, keep the scanner opposite to the object for 3 seconds,
and start to move when scan data shows. To improve the scan efficiency, the
movement should be continuous and uniform.
Markers/Feature
If the scanning presents purple color and

appears, it

indicates that the position tracking fails. You need to go back to the previous scan area and wait
for about 3 seconds and adopt merging features for about several seconds, and then try to scan
normally.
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Note：
1、When the scanned data quality is not good, please check the distance, and if the
brightness is proper in good distance condition. Check brightness through exposure
whether the light frame is clearly shooting on the object.
2、During scanning, please face the scanner to the object.
Markers/Feature: If the surface of the object has mark points, the software will recognize
the mark points and scan. The green area is the current scan, as shown below
Stick mark points on the object in random, avoiding sticking in one line, refer to scan
preparation.

When the position tracking fails, it will appear
previous markers to get to be tracked again to continue scan.

, you need to go back to the

Mixed Align
For some parts which are difficult for feature alignment, you may stick markers (≥4 markers) to
help with alignment. As shown below, markers only stick on the sphere and the rest of the model
does not need to stick.
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Texture Scan
In the process of texture scan, if blue data appears, it means that no texture has been
snapped in the region, so it is necessary to scan the area repeatedly.

52

Handheld Rapid Scan

6.3.3.2.

Pause

Click the button or press the button

on the scanner to suspend scanning

and check with it. After pause scanning and enter editing
state, you can quit editing state and save the data by
pressing the button on the device or clicking
lower right corner of the software.

6.3.3.3.

in the

Edit Tool

Edit buttons: ①Deselect ②Revert
③Delete ④Undo ⑤Show/Hide Stripe
⑥Shift + Left mouse: choose data ⑦Ctrl + Left mouse:
deselect selected data
You can edit the current part data after each scan. You can do the
below edition if the data has excess parts, both data and mark points
can be edited.
SHIFT+Left mouse：Select excess parts, the selected section is displayed in red, as shown below.
Ctrl + Left mouse: deselect selected data
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Delete selected data
Click the button or “DELETE” in the keyboard to delete selected data.
Undo
You can only undo the last deleted data.

Note：
Handheld scan mode does not support the deletion of mark points.
Handheld rapid scan, feature align, use the edit button to delete all the data,
continue scanning will restore the last deleted data.

Show/Hide Stripes
Click the button to switch the texture display and hide. Non-texture scan, there is no
such button.

6.3.3.4.

End editing

After pause scanning and enter editing state, as shown below, the icon

will show up in the

lower right of the window, click this icon after editing is finished to save scanning data. A prompt
box will pop up after clicking

, the editing will be applied if you click “yes” and the deleted

data will be irrevocable; if you click “no”, the editing will not be saved and the deleted data will
be revoked; if you choose to continue editing, the software remains current state.
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6.3.3.5.

Generate point cloud

Click the button after finishing scanning, you’ll have two options, Quality Priority and
Speed Priority. If you choose Quality Priority, it can optimize the scan data, but consume
more memory and take more time.

Quality Priority

Speed Priority

Note：
1. When new project choose the high resolution, the slow it saves, please be
patient.
2. After click ” Finish Scan”， if you continue to close the program Data loss may
occur. Please wait.

6.3.3.6.

Delete Your Data
Click the button to delete the whole data and restart scanning.
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6.3.4. After Scanning
6.3.4.1.

Mesh

When the scan is completed, click the botton, proceed to post-processing. You will see
two modes after clicking the button: Watertight and Unwatertight. Watertight usually
slower than unwatertigt. Texture scan mode will take more time compared to Non-Texture scan
mode.
Watertight
Closed model can be printed directly. After choose this mode, you should select
the object details.
Select High for objects with fine texture, select Med or Low for objects in smooth
surface or with less detail. The time for data processing is in relation to the detail
setting. The higher the level of details is, the longer time the processing takes. It may keep for a
long time in 95%, please be patient.
Select the object details：

Note：
1. Select High for objects with fine texture, select Med or Low for objects in
smooth surface or with less detail. The time for data processing is in relation to
the detail setting. The higher the level of details is, the longer time the
processing takes.
2. Watertight usually slower than unwatertigh, high resolution takes more
time, it may keep for a long time in 95%, please be patient.

Unwatertight
Unclosed model. The following picture is the watertight and unwatertight model.
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Watertight

Unwatertight

Texture watertight results are shown in the picture:
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6.3.4.2.

Data Post Processing

After meshing, the following dialogue box of data post processing will appear. You can simplify
the data per your request, do fill holes, sharpening or smoothing operations. Unwatertight and
watertight, the post processing of the interface as shown below.

Data simplification
After simplification, the polygon numbers, size and surface detail of data will be reduced
accordingly. Check the simplify check box and set the ratio, the default is 100%.
The comparison of detail between before simplification and after simplification (at 30% simplify
proportion).

Before simplification
After simplification
Fill holes
The default does not check the mark point and fill hole, check the fill hole you need set
perimeter, choose 10-100mm perimeter to fill the hole, less than the perimeter of the hole will
be filled. Mark point fill hole as an example.

58

Handheld Rapid Scan

Before

After

Note：
3. If the edge of the hole is not smooth may cause the effect is not good, not
recommended to fill hole.
4. Hole-filling: choose 10-100mm perimeter to fill the hole;

Smooth
The data to denoise processing, improve data quality, the figure before and after smoothing:

Before smooth

After smooth

Sharpen
Improve the overall clarity of the data, the figure below before and after sharpening:
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Before sharpen

After sharpen

Optimize the texture
This option is only available when the scan data is with texture. Click this function to optimize
color texture of the model, which can make the color closer to the model but take more time for
processing.

Not optimize

Optimize texture

Texture layout optimization
If you need to edit the texture later, you can select this function, but this is time-consuming.
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No optimization

6.3.4.3.

Texture layout optimization

Brightness/Contrast

After meshing project with texture, you may adjust brightness/contrast under the camera
viewport.
Brightness (-100—100): shows the brightness of the picture. The higher the value is, the brighter.
Contrast (-100—100): shows the contrast of the colors. The higher the value is, the more color
gradient layers.

6.3.4.4.

Save Your Data

Before merging can save data as asc . After merging, it can be saved as asc, stl, ply,3mf
and obj.

6.3.4.5.

Scale

Scaling the volume of scanning data, while the quantity of triangular facets and size of data
will not be changed.
Scaling result as reference: From left to right shows double size, original size and half size
respectively.

61

Handheld Rapid Scan

Scale window

6.3.4.6.

Scale result

Share Your Data

Click the button after merging to share data, it will show the dialog as below.
You can share your model to Sketchfab, while model title, username and user password
are required. Register an account and look at the shared model at http://sketchfab.com.

Note：
Sketchfab Normal account can only upload data maximum 50M, while Professional
account can share maximum 200M, and set model as private.
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6.3.4.7.

Solid Edge

If Solid Edge software is already installed, click the button
meshed STL data will also be exported to Solid Edge.

6.3.4.8.

to open the software. The

Project

You can new or open projects. The default project location is the desktop, then it will
remember where the user last created a new project.

Note:
1. Handheld rapid scan will follow whether the imported project is mark point align or
feature align. If imports a mark point align project or global mark point project when
there is no such function, you can’t do further scan but only edit or merge the project.
2. Handheld scan mode: When import project, and continue the scan, the scanning will
be in accordance with the imported project resolution.
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6.3.4.9.

Back to Home

If you want to change the scan modes, click the button to go back to the homepage to select
the scan mode.

6.3.5. Others
6.3.5.1.

Mouse Operation Prompts

Lower left corner of the interface is the mouse operation prompts:


Hold down the left mouse button: Rotate the object;



Hold down the middle mouse button: pan the object;



Hold down the mouse wheel: Scroll up and down to the object; scroll down to enlarge
the object;



Hold down the Shift + left mouse button: select the area on the object;



Hold down the Ctrl + left mouse button: deselect selected data;



Delete: Delete the selected area.

6.3.5.2.

Hot Key

ESC button: To close the pop-up windows, such as new project, select texture, choose mesh type
and so on.

6.3.5.3.

Frame rate, Points, Triangle

When scanning it will show the Frame rate, current points. After
merging, it will show current triangles in the lower right corner.
Handheld Rapid Scan’s scan speed is 10 frames/sec. When you
edit the scan data, the current points and the current triangles change in real time.

6.3.5.4.

Help
Click this button to get the operation manual and notes in more detail under the
current step.
The following picture shows the help information of new project.
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6.3.5.5.

Model Viewer

Einscan software can be a 3d viewer for ASC, OBJ, STL format file. Drag the 3d model to
Einscan software under scanning mode interface.
Click

on the 3d viewer window will close the model view. The scanning window will

be not affected.
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6.3.6. Work Offline
You can use software without scanner connection. You can do edition, manual align, delete, mesh,
save data, share data and so on.
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HD scan relies on reflective mark points to align. Stick mark points on the object in random,
avoiding sticking in one line.
Note：
The single scan range is 300mm X 170mm, public areas alignment require at least
four mark points. While placing the points, uniformly stick the mark points on the
object, and make sure that in each single scan area has at least 4 points.

Choose Handheld HD Scan mode, click”Next”.

After new project, select resolution. The higher the resolution, the better the details. If
select the “others”, you can drag the sliding block to other locations, flexible choice of point
distance.
Select resolution
Handheld HD Scan point distance range: 0.2mm—3.0mm, high 0.2mm, medium 0.5mm, low
1.0mm.
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6.4.1. Preview
Preview

Point the scanner to the object, then click
on software or press
on scanner
to run into PREVIEW mode. In this mode, it will start to capture data, but not recorded. In this
mode, you can:
3. Check working distance, and field of view for scanning;
4. Adjust a proper brightness before scanning.
Note: You need to preview objects with markers.

Adjust Brightness

1. When scanning distance is adjusted properly, double click
pressing “+, -“ button on the scanner. Double click

, and adjust the brightness by

to exit the brightness adjustment.

2. Brightness can be also adjusted via the brightness slider under the camera window
on the left side.
3. Brightness can be adjusted during scanning.
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To bright(X)

When brightness adjustment is over, click
start scan recording.

Good(√)

on the scanner or

Too dark(X)

in the software to

Handheld HD scan with 100 lines, scanning interface as follows:

Edit, finish scan, delete data, mesh, save data and share refer to Handheld rapid Scan.
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After add the Prime module, fixed and handheld rapid scan won’t be affected. Handheld HD Scan
will have two align mode(markers and feature) and scan more faster.

6.5.1 Align mode

There are two align modes, marker align mode and feature align mode. You may choose the
suitable align mode based on the actual condition.
 Marker align mode: You need to stick markers before scanning if the object contains
repeating features, symmetrical surfaces or have large planes. Try to make the markers
distributed evenly, but not in a pattern.
 Feature align mode: is suitable for objects with rich features on surface.

6.5.2 Adjust brightness

Check

below the camera viewport to adjust the brightness of Prime camera.
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EinScan-Pro+
brightness

camera

Prime
camera
brightness

Too bright (X)

Suitable (√)

Too dark (X)

Edit, finish scan, delete data, mesh, save data and share refer to Handheld rapid Scan.
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FAQ
1. What if no scan data when the turntable has rotated one circle?
Solution: Please make sure that the object won’t block the mark points on the turntable. Or,
there will be no fringe pattern, while turntable will be still rotating. If the align mode is mark
point, please make sure that the marks on the turntable are covered, so as not to affect the
scanning. Make sure that in each single scan area has at least 4 points.
2. What if the merging fails without mark points when the turntable has rotated several circles or
when it is under fixed scan ( without turntable ) mode?
Solution: Try to make sure there are at least 1/3 overlap between the current scan area and the
previous scan area and the object surface should be featured. For objects which are symmetric
and without rich features, using mark points or manual merger is recommended.
3. How to scan objects in transparent, semi-transparent or black?
Solution：Scan before spraying on the surface.
4. Under handheld HD mode and handheld rapid mode, what if there are straggling points?
Solution：
（1）Adjust the brightness, until the reflected graph and mark points are clear to be seen.
（2）Try to make sure the background environment is single, for example, to use a black cloth or
500mm away from other objects.（3）Do not scan opposite to the computer screen.
5. Under Handheld HD mode, what if only the mark points could be identified while there is very
less data captured?
Solution：Please do the HD scan calibration again，and during the calibration and capturing graph,
please make sure the calibration board and scan head are still.
6. Under handheld rapid mode, how to continue scanning when the merging fails?
Solution：Please move back to the scanned part (unreformed) for 3 seconds where there are
features and details, start to scan again when it is followed to scan.
7. How to scan thin-walled workpiece?
Solution：First, scan thin-walled parts should have transition zone which can stick with markers to
guarantee scanning can be transited from one side to another. Then follow the following steps.
(1) Stick markers on the transition zone. Make sure from the camera viewport, there are no less
than 4 mark points evenly distributed and not in one line.
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(2) Scan markers on the workpiece rapidly. Do spiral rotating via transition zone. Scan as many
mark points as possible on both sides and transition zone to build frame. The faster, the better.

(3) After building frame, scan the surface of workpiece slowly and carefully to finish the whole
scan.
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8. Under auto scan mode, if the turntable is not moving, but with a humming sound, how to
solve?
Solution：Disconnect power line and connect again in few seconds.
9．How to solve if after scan there is no data?
Solution：Open control panelRegion, then click “Additional settings”, decimal symbol choose “.”
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Safety Precautions


Keep well-ventilation. Environment temperature shall below 40 Celsius degree, and do not
use the device under an environment with flammable or corrosive gases or another similar
environment.



Please grab and place gently in the proper position, and do not squeeze it. Prepare
precautions like sunscreen, rain-proof, shock-proof and etc. No matter on sunny or rainy
days.



If the device could not function correctly, fixing the device by opening it by yourself is not
allowed. The device shall be repaired by professional technicians or under their instruction.



You should send the device to facilities with qualification for recycling it instead of dropping
into the household garbage when it is scrapped.
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Contact Us
Contact us
Email: einscan_support@shining3d.com

More scanning information
More scanning information can refer to http://www.einscan.com ---Support
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